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Module 3 

Spreadsheet modelling in 
management 

Introduction 
Now that you have laid the mathematical and statistical foundations, you 
can move into the area of modelling and decision making with electronic 
tools. In today’s world, it is essential to know how to use computer-based 
modelling and quantitative methods. Through these methods, 
computations that are time-consuming and almost impossible to do by 
hand become quick and simple. 

You can apply the techniques and ideas of the previous two modules in a 
very practical way by using spreadsheets. These can be found in 
computer software packages, and also as “freeware” on the Internet.  

Different spreadsheet options operate in very similar ways and there can 
be different versions of the same software (for example, the popular 
Microsoft Excel 2003 and Excel 2007), but the basic features remain the 
same. 

Do not worry if you have never used spreadsheets or Excel. Work slowly 
through all of the examples and remember that you learn by making 
mistakes. The aim of this module is not to turn you into a computer 
programmer, but to make you aware of the possibilities of electronic 
spreadsheets. 

Upon completion of this module you will be able to: 

 

Outcomes 

 master basic spreadsheet techniques; 

 generate graphs, charts and tables electronically to display data; 

 apply sensitivity analysis to cash flow problems; 

 evaluate projects and capital budgets; 

 use ANOVA analysis on data; 

 apply spreadsheet tools such as Data Analysis and Goal Seek; 
and 

 use simple macros in VBA. 
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Unit 9 

Introduction to spreadsheets 

Introduction 
The objective of this unit is to introduce you to the basics of electronic 
spread sheets. While the unit is intended for students who have little or no 
previous experience with spread sheets, we assume you have some 
previous experience using a computer.  

The rest of the material (from Unit 10 onwards) covers more advanced 
features and shows you how to apply the techniques developed in 
Modules 1 and 2 to spread sheets. 

There are two main spread sheet packages: Microsoft’s Excel (versions 
2003 or 2007) and OpenOffice.org’s Calc (which can be downloaded free 
from www.openoffice.org). 

Upon completion of this unit you will be able to: 

 

Outcomes 

 understand menu bars, toolbars and dropdown menus; 

 enter, change and delete data in a cell; 

 use formulas, references and functions; 

 save and retrieve files; 

 format the appearance of a cell’s contents; 

 change the width of a column; 

 insert rows; and 

 move data from one location to another. 

What is a spreadsheet? 
Open your spread sheet software. Click on the Excel icon (picture) or the 
OpenOffice.org Spread sheet icon on your desktop or menu bar. 
Although all of the concepts are explained using Excel version 2003, all 
spread sheet software applications work in a similar way, so you should 
be able to adapt the instructions to your needs.  

If you don’t have Excel, use the following instructions to download 
OpenOffice.org from the Internet free of charge: 

OpenOffice.org is an open-source office software suite that can be 
downloaded and used free of charge. The suite includes programs for 
word processing (Writer), spread sheets (Calc), presentations (Impress), 
graphics (Draw) and databases (Base). 
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It is available for different languages and platforms. Files can be 
transferred between OpenOffice.org and many other office suites. 

To download OpenOffice.org: 

1. Access the OpenOffice.org website by typing this in your browser 
window: 
http://www.openoffice.org 

2. Choose the second option (“I want to download OpenOffice.org”) by 
clicking on it. 

3. This will start downloading the OpenOffice software for the 
Windows platform in US English. (There is a link if you want to 
download it for a different platform and/or language.) 

Note: The file is quite big (approximately 148 MB) and might take some 
time (45–60 minutes) to download, especially if you have a slow 
connection 

4. Once downloaded, run the file (by double-clicking on the file name). 
This will load the installation files onto your computer. This is a short 
process and once the files have been loaded, installation is automatic. 

5. You will be guided through the installation steps. Choose the 
Complete installation to install all the programs and features of 
OpenOffice.org. The installation process should only take a few 
minutes. 

Ensure you tick the box to make an OpenOffice.org icon on the 
desktop.  

If you want to install only part of the software (for example Calc, the 
spread sheet program), choose the Custom option. This will use less 
space  (but only use this option if you are an advanced user).  

6. To run OpenOffice.org, double-click on the icon that has been 
created on your desktop. 

The first time you run OpenOffice.org, you will be taken through a 
short registration process, after which the program will open. 

7. To open a spread sheet, click on the Spread sheet icon. 

 

In Excel, open a new workbook by clicking on the New Blank Document 
icon in the Standard Toolbar. Or click on <File> and then <New>. 

On the screen is a spread sheet, which is a grid of rows and columns with 
row and column headings, as shown in Figure 1 (Excel) and Figure 2 
(OpenOffice Calc). 
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Figure 1 Spreadsheet for Excel 

The empty blocks are called cells. The top line on your screen is called the title bar and should say 
something like “Microsoft Excel – Book 1”. 

 
Figure 2 Spread sheet for OpenOffice Calc 

 

 

Title bar 

Menu bar 

Toolbar 

Formula bar 
Cell A1 

Name box 
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Menus and toolbars 
Below the title bar is a line with these names (for Excel 2003): 
File    Edit    View     Insert     Format     Tools     Data    Window    Help 

Or, for Excel 2007, the menus are labelled: 
Home   Insert   Page Layout   Formulas   Data   Review   View   Acrobat 

These lines form the menu bar. Clicking on any of these words activates a 
dropdown menu with several options. For example, if you click on 
<View> the following dropdown menu will appear: 

 
Figure 3 

In the case of Excel 2007, a new row of icons will appear. 

Below the menu bar are a few lines with icons (pictures). Investigate the 
menus and icons to see what features are available on your particular 
spread sheet. These features appear on toolbars as sets of icons. Moving 
the mouse over an icon makes a screen tip (description of the feature) 
appear. The ? icon is a Help facility and is very useful. 

The rest of this module refers to Excel 2003. Practise using your 
particular spread sheet so that you become familiar with it – there is no 
substitute for spending time with your computer. 

Follow these steps to ensure you have the toolbars showing on screen that 
you will use later on by: 

 Click <View> on the menu bar. 

 If there is a tick mark next to Formula Bar on the dropdown 
menu do nothing, otherwise click <Formula Bar> and <View> 
again. 
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 Click <Toolbars>. Another dropdown menu with the names of 
other available menu bars appears. If there are tick marks next to 
Standard and Formatting, do nothing, otherwise click <Standard> 
and <Formatting> so that tick marks appear. 

 
Figure 4 

To make any dropdown menu disappear from the screen, click anywhere 
on the grid itself and the dropdown menu will disappear. 

Cells 
Look at the grid (spread sheet) as shown in Figures 1 or 2. Above the 
cells you will find the toolbars, showing icons such as a clean page, an 
opened folder, a printer, scissors, and so on. When you move your mouse 
pointer to any of the icons on the toolbar and hold it still, a label appears 
with a description of that icon’s function. For example, when you click 
on the blank page, a new worksheet will be opened.  

The cells themselves are named for the row and column in which they 
appear. For example, the cell in the first row, second column from the left 
is identified as B1, while the cell in the fifth row and fifth column is E5. 
This name appears in a block, called a name box, which sits above 
column A. 

Each cell may contain a number, some words or a formula. To enter a 
number or text into a cell, click the cell where you want to enter the data. 
Then type the data and press <Enter> or <Tab>. You can change the 
entry in a cell by clicking on the cell again and typing in a new value to 
replace the old one. To delete the entry in a cell, click on it and press 
<Delete> on the computer keyboard. Practise putting data into cells and 
deleting it. 
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A useful pair of icons is the Copy and Paste combination. The icon for 
Copy is double pages and Paste is shown by a clipboard with a page. To 
copy the contents of a cell (its numerical value or formula), click on the 
cell, click the Copy icon, click on the new cell and click the Paste icon.  

Note: The contents of a cell you click on will appear in the blank line 
labelled fx above the grid. This line is where you can enter formulas or 
functions and is called the Formula Bar. In Excel 2003, you can click on 
the <Insert> menu and then on <Function>. A list of functions you can 
use will appear. In Excel 2007, you can click on the Formulas icon and 
new icons will appear with functions such as Financial and Math.  

Saving a workbook 
To save a workbook, click on <File> and <Save> or on the  icon. Give 
the workbook an appropriate title and then save it. In Excel 2007, click on 
the Microsoft icon at top left, then on <Save>. 

As you work on a file, keep on saving this file by clicking the  icon. It 
will automatically be saved under the same name. You can save a copy of 
the file with a new name by clicking on <Save as> in the <File> menu. 
When you start a new Excel session and you wish to retrieve your model, 
you do the following: 

Click <File> in the menu bar, then <Open> in the dropdown menu, then 
choose and click the name of the file you want in the <File name> box. 
Click <Open>. 
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Activity 3.1 

 

Activity 

Make a spreadsheet 

What will you do? 

1. Open a new workbook. Enter this table in cells A1 to B7. 

Year Sales 

1 112 

2 243 

3 265 

4 310 

5 400 

6 450 

2. Save the workbook as Annual Sales Figures. Change all sales entries 
by adding 100 to each number. Save the workbook and close. 

3. Open the workbook again. Enter the words “Total Sales” in Cell A9. 

4. Create a new workbook. Enter this table in cells A1 to B5. 

1 3 

2 5 

3 7 

4 9 

5 11 

5. Copy the table to cells E8 to F12. Save the workbook as Linear 
Function. 

Note: When you enter numbers greater than 1,000 in Excel, it is best to 
omit the comma.   

Formulas and functions 
Let’s perform operations on the data in cells. Open a workbook, enter any 
numbers in cells A1 and A2 and save it as Practice. 

Click on the cell where you want the answer to an operation to be 
displayed. Then click in the empty formula bar next to fx (just above 
column C in the grid) to enter the formula. A formula in Excel always 
begins with an equal sign (=), followed by what the formula calculates. 
Then press <Enter> on the keyboard. The result of the formula is 
displayed in the cell. 

For simple mathematical operations, use these symbols in spread sheet 
calculations: 
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+ for addition − for subtraction 

* for multiplication / for division 

^ for exponentiation 

Formulas and operations are usually applied to cells. If you want to 
calculate the ratio of the numbers appearing in cells A1 and A2 and 
display that answer in cell A3, follow these steps: 

 Click on A3. 
 Click in the fx box. 
 Type in =(A1/A2). 
 Press <Enter>. 

The answer will appear in A3. If you change the values in A1 and A2 and 
click on cell A3, the new answer will appear. Practise the different 
operations (addition, multiplication, and so on). 

If you want to copy a formula from one cell to another cell, click on the 
first cell, click on the Copy icon, click on the new cell and click the Paste 
icon. 

Apart from the easy mathematical operations, spread sheets have built-in 
functions, as mentioned above. 

To apply a formula to an entire column, row or block of cells, you need to 
reference the range of cells. 

Here are some examples: 

Reference Refers to 

A1:A5 the column consisting of cells A1, A2, A3, A4 and A5 

A2:D2 the row consisting of cells A2, B2, C2 and D2 

A1:B8 the block consisting of the 16 cells in rows 1 to 8 and 
columns A to B 
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Activity 3.2 

 

Activity 

Do calculations in 
spreadsheets 

 

What will you do? 

Open a workbook and enter this table in cells B2 to C6: 
 

12 8 

7 15 

10 12 

18 9 

11 20 

a) Enter the word “Sum” in A7. Calculate the sum of numbers in 
each column and display the answers in B7 and C7. 

b) Enter “Product” in D1. Calculate the product of numbers for each 
pair Bi, Ci (i = 2, 3... 6) and display the answers in column D in 
cells D2 – D6. 

c) Enter “All Sum” in A10. Calculate the sum of all numbers from 
B2 to C6 and display the answer in A11. 
Check that A11 = B7+C7. 

Here’s our feedback 
a) Method for calculations: Click on B7. Click in fx formula bar. Type 

in: =(B2+B3+B4+B5+B6). Press <Enter>. The answer “58” should 
appear. 

You can repeat the process for C7 or do the following: Click on B7, 
click Copy, click on C7, click Paste. The answer “64” should appear. 
You will notice that when the formula is copied, Excel cleverly 
changes the cell references from B to C automatically. 

b) Click on D2. Click in the fx box. Type in: =(B2*C2). Press 
<Enter>. The answer “96” appears. Click on D2 again, click Copy, 
click on D3, click Paste. The content of D3 will have been adapted 
to = (B3*C3). Copy and paste for each cell down to D6. The cell 
references will automatically be changed.  

If you do not want cell references to change when copying and 
pasting, you must give absolute references to such a cell. For 
example, if you want the formula in D3 to be = (B2*C3) — that is, 
the C-cells must change under copying but not the B-cells — then 
your original formula should read: = ($B$2*C2). The $ symbol 
fixes the cell reference. 

c) Check that the answer is 122. 
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Note:  The entry in cell A11 comes from the formula = SUM(B2:C6). 
This is an example of using range references and built-in functions. SUM 
is a function that sums everything in the range given in brackets. So 
instead of entering =(B2+B3+B4+B5+B6+C2+ C3+C4+C5+C6) in the 
function box after clicking on A11, you can enter =SUM(B2:C6 

Your workbook for Activity 3.1 should look like this: 

 
Figure 5 

Some Excel functions 
Excel has many built-in functions. They are always displayed in capital 
letters. 

AVERAGE calculates the average of a range of values. 

MAX finds the largest value in a specified range. 

MIN finds the smallest value in a specified range. 

STDEVP calculates the standard deviation of values. 

VARP calculates the variance of values. 

FV calculates the future value of a stream of periodic, equal 
payments. 

PV calculates the present value of a stream of periodic, equal 
payments. 

NPV calculates the net present value of a stream of periodic 
cash flows discounted at a fixed rate. 
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NPER calculates the number of periods required for an annuity 
to reach a given future value. 

PMT calculates the annuity payment required to pay back a 
loan over a given period. 

IRR calculates the internal rate of return of a stream of 
periodic cash flows. 

SKEW calculates the skewness of a distribution. 

KURT calculates the kurtosis of a distribution. 

Remember that a function must be preceded by “=” and followed by 
brackets containing the range of cells. 

To find the whole range of available functions, click on an empty cell, 
then on <Insert> and then <Function>. Choose a category (if you’re not 
sure which one, choose “All”) and the specific function you want to use. 
Click on <OK> to enter that formula into the cell you have chosen. You 
can then enter the range of cells you want to apply the formula to.  

To find out more about any of these functions and how to use them, you 
can use the Help function on the menu bar. 

Activity 3.3 

 

Activity 

Calculate average and 
variance  

What will you do? 

1. For Activity 3.2, calculate the average of the numbers in each 
column. 

2. Calculate the variance of these numbers:  
112, 114, 110, 116, 115, 118, 117.5, 113, 114.5. 

Here’s our feedback 
1. In Cell A8, type the word “Average”. 

Click on B8, click in Formula bar fx and type =AVERAGE(B2:B6). 
Press <Enter>. You can also click on  <Insert> and <Function> then 
choose Average. 

Click on B8 again, click Copy, click on C8 and click Paste. Press 
<Enter>. You should see values 11.6 and 12.8, respectively, in cells 
B8 and C8. 

2. Enter the numbers in a column in a workbook. Choose a cell to 
display the answer. Click on it and enter the function VARP and the 
correct range for the arguments in the formula bar fx. It should look 
like Figure 6. 
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Figure 6 

The variance is 5.858 (rounded off to three decimals). 

Note: You will notice two functions that deal with variance:  

VAR and VARP. VARP assumes the given values xi form the total 
population of values and is based on the formula:  

variance (x) = s2 = 
N

xxi  2)(
 

VAR assumes the given values form only a sample of a greater 
population of values, and is based on the formula:  

s2 = 
1

)( 2




N

xxi

 

You can revise these concepts in Unit 6 of Module 2. 

Changing the width of cells and aligning entries 
You can change the width of columns. If, for example, you want to widen 
column A, move the mouse pointer onto the line (boundary) between the 
blocks for A and B in the row headings. When you’re on the right line, a 
special symbol (a vertical line with two left-right arrows) appears. Drag 
to the left or right (by pressing and keeping the left mouse button down, 
then moving) until the column is the width you want. 
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Learn to align entries to improve the spread sheet’s appearance. Follow 
these steps to align the heading in cell A1 to the right: 

 Click on A1. 

 Click <Format> on the menu bar and then click <Cells> on the 
dropdown menu. Click the Alignment tab. 

In the Horizontal box, click on the arrow () to reveal the available 
options and then click on Right. Click OK. Activity 3.2 Activity 3.2 

Activity 3.4 

 

Activity 

Do more calculations 

What will you do? 

Create a new file in Excel and enter the data from the Module 2 section 
“Charts, graphs and histograms”. The table gives the sales figures for the 
number of pairs of sunglasses sold in a shop in an island resort. 

Month and sales figure Month and sales figures 

January:            8 July:                 32 

February:          6 August:            44 

March:              9 September:      36 

April:               15 October:          21 

May:                18 November:      12 

June:                26 December:       10 

Choose suitable headings and right-align them. Calculate the following in 
the workbook: 

1. Average monthly sales figure. 

2. Minimum sales figure. 

3. Median and mode for sales. 

4. Skewness of the distribution of sales. 

5. Variance in sales over the year. 

Applications: Project evaluation 
This section returns to the “Applications” discussed in Unit 1 in Module 
1, with the aim of evaluating a specific project by doing a sensitivity 
analysis and comparing different projects.  

Sensitivity analysis means asking “What if?” questions for changes in the 
discount rate. You then make decisions based on the values of the criteria 
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Net Present Value (NPV), Profitability Index (PI) and internal rate of 
return (IRR). Electronic spread sheets make these analyses simple, 
whereas in Module 1 all calculations were done by hand and you did not 
consider the IRR there precisely because of computational difficulties. 

Internal rate of return (IRR) 
The internal rate of return gives the break-even rate of return for the 
project — that is, the rate r at which initial investment C0 = PV of cash 
inflows, or NPV = 0. This means solving for r from the equation: 

)1(
1

r

C


 + 

2
2

)1( r

C


 + 

3
3

)1( r

C


 +…+ 

n
n

r

C

)1( 
 = C0 

If the IRR is larger than the given required rate of return, the project is 
profitable. 

Spreadsheet modelling for projects 
Excel has functions for PV, NPV, IRR, and so on under the Financial 
category. Locate them and read the descriptions in the Functions box. Use 
the Excel Help function for assistance with how functions work in Excel. 

Activity 3.5 

 

Activity 

Work with a cash flow 
stream 

What will you do? 

You are given a cash flow stream over 12 months. The initial investment 
(month 0) was 12,000 cedi. This is an outflow. The required rate of return 
is 1.14% per month.  

1. Enter the data in an electronic spread sheet in cells A3:A15 (months 
0–12) and B3:B15 (outflow and inflows). Remember that an outflow 
is negative, so B3 should be −12000.  

2. Enter the words “Discount rate” in cell C3 and the rate into D3.  

3. Enter appropriate headings in A1 and B1 for the data in the 
workbook.  

4. Calculate these formulas:  

a) Average monthly cash inflow 

b) Maximum monthly cash inflow 

c) Standard deviation of cash inflows 

d) NPV 

e) PI (profitability index) 

f) IRR 
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 Month Cash 
flow 

Month Cash 
flow 

Month Cash 
flow 

1 1,000 5 2,000 9 1,500

2 1,100 6 2,000 10 1,000

3 950 7 1,800 11 2,000

4 1,200 8 1,200 12 1,000

Remember to save your file regularly. 

 

Here’s our feedback 
4. 

a) Enter the word “Average” into cell A16.  
Click on B16 and click in fx box.  
Click <Insert> , <Function> and choose AVERAGE.  
Enter range (B4:B15). The Formula bar should read:  
=AVERAGE(B4:B15). Click <Enter>.  
The value 1,395.83 should be displayed. 

b) Enter the word “Maximum” into cell A17. 
Click on B17 and click in fx. 
Click <Insert> , <Function> and choose MAX. 
Enter range (B4:B15). 
Click <Enter>. The value 2,000 should be displayed. 

c) Enter the word “Standard dev.” into cell A18. 
Click on B18, click in fx, <Insert> <Function> and choose 
STDEVP. Enter range (B4:B15). 
Click <Enter>. The value 418.56 should be displayed. 

d) Enter the word “NPV” into cell A20. 
Click on B20, click in fx, <Insert> <Function> and choose NPV. 
Enter arguments (D3,B4:B15) and add B3. 
The Formula bar now reads: =NPV(D3,B4:B15)+B3. 
Make sure that the value for the discount rate is entered as 1.14% 
or as 0.0144 into D3. 
Click <Enter>. The value 3,531.78 should be displayed. 

e) Enter the word “PI” into cell A21. 
Click on B21, click in fx and enter =((B20/(−B3)+1). 
Click <Enter>. The value 1.2943 should be displayed. 

f) Enter the word “IRR” into cell A22. 
Click on B22, click in fx, <Insert>, <Function> and choose IRR. 
Enter argument (B3:B15, guess). 
In place of guess you can enter a value such as the discount rate – 
in this case, 1.14% – or omit the guess. 
Click <Enter>. The value 5.3% should be displayed. 
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Activity 3.6 

 

Activity 

Determine profitability and 
analyse sensitivity 

What will you do? 

Refer to Activity 1.8 in Module 1. 

A company in Papua New Guinea has 30,000 PGK (kina or K) to invest in 
either Project A or Project B. Each project runs over three years. The 
expected cash inflows at the end of each year are displayed in this table. 

Project A Project B 

Year 1:  K 10,000 Year 1:  K 14,000 

Year 2:  K 12,000 Year 2:  K 12,000 

Year 3:  K 14,000 Year 3:  K 10,000 

The required rate of return (discount rate) is 8 per cent p.a. 

1. Set up a spread sheet to determine which project is most profitable at 
this point. Use NPV (net present value) as the criterion. 

2. Perform a sensitivity (“what if?”) analysis to take into account a 
change in discount rate of 2 per cent, either upwards or downwards. 
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Activity 3.7 

 

Activity 

Understand the 
terminology 

What will you do? 

Use this terminology table to record any terms or words you’re uncertain 
about. 

This activity is an opportunity to consolidate your understanding of new 
terminology and concepts you encountered in Unit 9. Fill in the terms you 
have learned and then write your own descriptions of them. 

 

 

Terminology 

Term Description 

 :  

 :  

 :  

 :  

 :  

 :  

  :  

  :  

  :  

Remember these key points 
 Using spread sheets facilitates project analysis and sensitivity 

analysis. 

 Practice, practice and more practice will make using spread 
sheets a pleasure. 
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Unit summary 
You have successfully completed this unit if you can: 

 

Summary 

 enter data into the cells of a spreadsheet; 

 set up headings and align them; 

 enter formulas into the function box fx; 

 use the Excel functions from the drop-down menu; and 

 assign ranges as arguments for functions. 
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Unit 10 

Tables, charts and graphs in Excel 

Introduction 
Tables and charts are a convenient way to display interpretations of data. 
The tables, charts and graphs you considered in Modules 1 and 2 are 
simple to produce in an electronic spread sheet.  

Upon completion of this unit you will be able to: 

 

Outcomes 

 set up tables of data in spread sheets; 

 generate frequency tables and histograms; 

 present data and equations with charts and graphs; and 

 analyse data with the Descriptive Statistics analysis tool. 

Tables and column charts 
To display data in a graph, select the data, then choose <Insert> from the 
menu bar and click on <Chart>. Alternatively, in the top toolbar of the 
worksheet you will find an icon called Chart Wizard. Click on it. You 
will see a list of Standard Type and Custom Type charts and graphs. 

This table shows a certain country’s annual growth rate as a function of 
interest rate over 5 years. Enter this into a worksheet in cells A1 to B6.  

Annual interest 
rate (%) 

Annual growth rate for 
country (%) 

4 6.4 

6 5.0 

8 3.7 

10 2.5 

12 1.6 

Excel presents the data contained in a worksheet as a chart or graph. The 
Chart Wizard provides a quick way to generate a chart or graph: 

 Select the cells that represent the data you want to plot in the 
chart – for example, the growth rate values contained in cells B2 
to B6. You select cells by highlighting them: click and hold on 
B2, then move the mouse down to drag across the column to B6. 

 Click <Insert> on the menu bar and then click <Chart> on the 
dropdown menu. Otherwise, click directly on the Chart Wizard 
icon in the toolbar. 
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Step 1 offers a choice of standard or custom-type charts. We will discuss 
column charts. 

A. Click on Column and then on Clustered column. Click on <Next>. 
A column chart will appear. 

Step 2 makes sure the correct data is used for the chart. Since you have 
highlighted column B2:B6, this will appear as data range 
Sheet1!$B$2:$B$6. If you have not chosen the range earlier, you can now 
enter B2:B6 in the Data range box. Make sure Columns is ticked, since 
the data is in column form. 

If you click on the Series tab, you can give Series1 the name “Growth 
Rate”. Click on <Next>. 

Step 3 allows you to: 

 add titles 

 remove or add gridlines 

 remove or label the Legend box to the right of the graph, and so 
on.  

For example, you can label the x-axis as “Year”. (The only way to learn 
how to use the options is to try them out and see how the graph is 
affected.) 

Step 4 allows you to place the chart on one of the sheets that make up the 
workbook. When you click on <Finish>, the final graph appears. 

 
Figure 7 

If you want to edit, right-click inside the frame of the graph and a list of 
options will appear. Click on Chart options and make the necessary 
changes. You can choose to display Interest rates by highlighting A2:A6 
instead. 

B. The clustered column chart in Figure 7 is not sufficient, as the 
interest rates are not displayed. Highlight the block A2:B6 to 
include both columns. Click on Column and again on Clustered 
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column. Both rates will appear as columns. Go through the steps to 
obtain the chart shown in Figure 8. 

Figure 8 

This enables you to see both quantities and how they change relative to 
each other. 

C. Try a custom-type chart: Choose Line-Column. Go through the 
steps to obtain Figure 9. 

Figure 9 

A disadvantage of column charts is that they are limited to category-type 
data – that is, the data is in groups (in this case, years) labelled 1, 2, 3... 
along the x-axis. We do not have growth rate as a function of interest rate. 

Scatter graphs, lines and curves 
The same data can be used to draw scatter graphs. Select A2:B6 by 
highlighting the block and then click on Chart Wizard. 

Click on XY (Scatter) and choose the picture with the description 
“Scatter with data points connected by lines”. Click <Next> and ensure 
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the data range is correct (both columns); also check that “Columns” is 
ticked, as the data has been entered column-wise. 

Click <Next> and enter titles for your graph and the axes. Remove 
gridlines (if you wish) and the Series label under Legend (unless you 
want it). Click <Next> to choose a sheet and then <Finish>. If you want 
to remove the grey shading in the graph area, right-click inside the Plot 
area and click <Clear>. 

Because you entered Interest rate in Column A, this will be interpreted as 
the independent variable x and displayed along the x-axis. Growth rate in 
the B-column will be displayed on the vertical (y) axis. Your graph will 
look like this: 

Figure 10 

Remember: The final look of a graph is your choice, and the only way to 
get comfortable with Chart Wizard is to practise using it. Save 
workbooks with logical file names so you can easily find them again. 

Activity 3.8 

 

Activity 

Practise graphs 

What will you do? 

Use the data in the various examples and exercises in Module 2 to 
generate column charts and scatter graphs. 

Lines and planes 
The Chart Wizard can generate lines from formulas in two-dimensional 
space and planes in three-dimensional space. 
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Activity 3.9 

 

Activity 

Price/Quantity relations 
and Break-even point with 

Excel 

What will you do? 

1. The relation between quantity Q of bags ordered by a buyer from a 
retail outlet and price P charged per bag is given by: 
P(Q) = 250 – 0.14 Q, for Q > 0 

The units for P will be in the currency of the country. Represent the 
relation as a straight-line graph in a spread sheet. 

Interpret and discuss the result. 

2. Total production cost TC = fixed cost + variable cost 
                                         = 12,000 + 50N 
where N is the number of items produced. 

Total revenue R = PN where P is the selling price per item. 

a) For P = 80, use Chart Wizard to determine the break-even point. 
(All numbers here are in Jamaican dollars, JMD). 

b) For P = 100, use Chart Wizard to determine the break-even point. 

Here’s our feedback 
1. First, draw a table in Excel. Open a new workbook and write the 

titles “Quantity Q” in cell A1 and “Price P” in cell B1. Put the 
independent (Q) variable in the first column. Enter a number of 
suitable values for Q in the A column. Click on B2. Click in the 
Function bar. Enter the equation: =(250 – 0.14*A2). After pressing 
<Enter> the answer should appear in cell B2.  

Now click on B2 again and Copy. Click on B3 and drag down to 
highlight the B-column up to the last Q value. Click Paste. The 
equation will have been adapted to all the values for Q and the 
answers for P should appear. 

                   A                         B 

Quantity Q Price P 

0 250 

50 243 

100 236 

150 229 

200 222 

400 194 

Now highlight the block with both columns, click Chart Wizard, choose 
Scatter (XY) and an appropriate sub-type (such as smoothed lines without 
markers) and continue the steps. A graph such as Figure 11 should 
appear. 



Unit 10 Tables, charts and graphs in Excel 
  

 

 
26 

 

 
 

 
Figure 11 

Clearly, the unit price of bags decreases with increasing quantities. The 
price of one bag is 249.86 and the price per bag for 100 bags is 236.00. 
This is a 5.5 per cent saving per bag. 

2.  

a) Draw the two lines R = 80N and TC = 12,000 + 50N on the same 
set of axes, with N on the x-axis. 

First set up a table in block A2:C7. 
Put headings N, R and TC in Cells A1, B1 and C1. 
Set N = 100, 200, 300, 400, 500, 600 in the first column. 
Enter the formula: =(80*A2) in B2; copy and paste into B3:B7. 
Enter the formula: =(12000+50*A2) into C2. 
Copy and paste into C3:C7. 
Highlight A2:C7 and click on Chart Wizard. Choose Scatter(XY) 
and Line. 
 
Go through the steps to obtain a graph like the one below. Now, 
if you move the mouse pointer to the point of intersection in the 
chart area, the coordinates (400, 32,000) will appear. This is the 
break-even point: 400 items should be manufactured to break 
even, and more to make a profit. 
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Figure 12 

b) Repeat the exercise for P = 100. Choose more data points to draw 
the graph. The intersection is at N = 240, where TC = 24,000.  
In this case, the coordinates of the point of intersection will not 
appear under the mouse pointer, unless you chose 240 as a data 
point to draw the graph.  

You will have to estimate the intersection co-ordinates from the 
graph. 

 

Representation of parabolas 
Parabolas can be represented in Excel. 

Here’s an example:  

Consider the supply-demand case study from Module 1, Unit 3, 
“Applications of non-linear functions”. The supply and demand for a 
particular product are described by these functions: 
PS = QS

2 + 2QS + 16      and      PD = QD
2  2QD + 20 

(PS is the price per item the supplier will accept, and PD is the price the 
buyer is willing to pay. QS is the number of products supplied and QD is 
the number of products demanded.) 

You want to find the equilibrium point where PS = PD. This is the 
intersection point for the two parabolas. 

Follow the steps in Activity 3.9, question 2, to obtain the graph in 
Module 1, Figure 28.  

Column A should contain these values for Q (thousands): −6, −4, −2, 0, 
2, 4, 6. Column B should contain the corresponding values for PS and 
Column C should contain values for PD.  

The formula to be entered in B2 is: 
=(A2^2 + 2*A2 + 16). 
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Then copy and paste into B3:B8.  
The formula to be entered in C2 is: =(A2^2 − 2*A2 + 20).  
Then copy and paste into C3:C8.  
Highlight A2:C8 and choose Scatter(XY) with smoothed line without 
markers. 

 
Figure 13 

You can move the titles of axes by clicking and holding on them, then 
dragging the title box to the new location. 

The intersection is at Q = 1,000 and P = 19. These values can be found, 
approximately, from the graph. Remember that 1 on the Q-axis means 
1,000. 

Activity 3.10 

 

Activity 

Get the graphs right 

What will you do? 

1. The budget for a small farm consists of expenses and income. 
Total expenses TE= 10,000 + 235N, where N is the number of units 
of land planted. Total income I = 1,400N. 

Determine the approximate budget-balancing (break-even) point with 
Excel’s Chart Wizard. (All numbers are in Ghanaian naira.) 

2. The supply and demand for a particular product is described by these 
functions: 
PS = 2QS

2 − 6QS + 2      and PD = QD 
2 + 2QD + 6 

(PS is the price per item the producer will accept and PD is the price 
the buyer is willing to pay. QS is the number of products supplied and 
QD is the number of products demanded.)  

Use Excel to find the equilibrium point graphically. 
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Frequency distributions, histograms and data analysis 
Excel has the capability to generate a frequency distribution for a large 
set of data. (Revisit Module 2: A frequency distribution presents the 
distribution of values in a data set. The range of the data values is divided 
into appropriate intervals, and the number of values occurring in each 
interval is counted.) 

Consider this data set for a company’s revenue, which you will enter into 
a worksheet: 

 

Figure 14 

To set up a frequency distribution for this set of values, you first find the 
range of the data values: 

 Find the smallest data value in the set by entering in any open 
cell (for example, H4) the function: = MIN(B4:F15). 

 Find the largest data value in the set by entering in any open cell, 
(for example, H5) the function: = MAX(B4:F15). 

This gives the range of data values as 120 to 258. You must now select a 
set of intervals that will cover this range – use five intervals: 

0 to 120, 120.1 to 160, 160.1 to 200, 200.1 to 240, 240.1 to 280. 

Now that you have determined the interval boundaries, enter their end 
points onto the worksheet. Enter these in cells B20 to B24.  

Excel always considers the first interval as an open interval, including all 
values less than or equal to the end point, in this case  120. Also, Excel 
always considers an extra interval after the last end point entered – that is, 
the open interval including all values greater than the last end point, in 
this case > 280. 

A B C D E F G H
2
3 MONTH 1996 1997 1998 1999 2000
4 JAN 120 176 181 183 154
5 FEB 124 171 190 180 176
6 MAR 136 187 212 176 163
7 APR 144 218 215 174 161
8 MAY 137 211 233 179 171
9 JUN 138 197 253 177 179

10 JUL 134 207 241 174 194
11 AUG 150 196 258 173 211
12 SEP 154 218 235 150 220
13 OCT 167 197 239 163 197
14 NOV 184 197 200 173 189
15 DEC 180 184 171 144 201
16
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Excel refers to the range of cells B4:F15 containing the source data as the 
data array, and to the cells B20:B24 containing the interval end points as 
the bin array. 

Here’s how the frequency distribution is calculated: 

 Select (highlight) a range of adjacent cells into which Excel will 
enter the distribution – in this case, the six cells C20 to C25. 

Figure 15 

Notice that an extra cell, C25, is included in the selection, to 
provide for the extra interval considered by Excel. 

 Type in the formula box: =FREQUENCY(B4:F15,B20:B24). 

Notice that the first argument (B4:F15) represents the data array, 
while the second argument (B20:B24) represents the bin array.  
You can also click on <Insert>, <Function> and choose 
Frequency. 

 The FREQUENCY function is a so-called array function, which 
results in a range of values rather than a single value.  
Now hold down <Ctrl> and <Shift> and press<Enter>. 
 

The results are in Figure 15. 
 

A B C D E F G H

1
2
3 MONTH 1996 1997 1998 1999 2000
4 JAN 120 176 181 183 154
5 FEB 124 171 190 180 176
6 MAR 136 187 212 176 163
7 APR 144 218 215 174 161
8 MAY 137 211 233 179 171
9 JUN 138 197 253 177 179

10 JUL 134 207 241 174 194
11 AUG 150 196 258 173 211
12 SEP 154 218 235 150 220
13 OCT 167 197 239 163 197
14 NOV 184 197 200 173 189
15 DEC 180 184 171 144 201
16
17
18 FREQUENCY DISTRIBUTION FOR PRICE
19
20 120 1
21 160 11
22 200 33
23 240 12
24 280 3
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Another way to generate the frequency distribution is to make use of the 
Data Analysis tool, which you will find on the Tools dropdown menu: 

 Click <Tools> on the menu bar and then <Data Analysis>. 

If Data Analysis did not appear: 

 Click <Tools> on the menu bar. 
 Click <Add-Ins> on the dropdown menu.  
 Click <Analysis ToolPak>.] 

If Analysis ToolPak is not listed in the Add-Ins dialog box, click 
<Browse> and locate the drive, folder name and file name for the 
Analysis ToolPak add-in, Analysis32.xll (usually located in the 
Library\Analysis folder), or run the Setup program if it isn’t installed. 

 Click <Histogram> in the Analysis Tools box. 
 Click <OK>. 
 Enter B4:F15 in the Input Range box. 
 Enter B20:B24 in the Bin Range box. 
 Enter B27 in the Output Range box. 
 Click <OK>. 

The result is shown here: 

Figure 16 

Note: When using OpenOffice, you have to download a set of three 
macros to perform statistical analysis: Basic Statistics, Multivariate 
Statistics and Applications. This provides you with the functionality of 
Excel’s Analysis ToolPak. These macros can be downloaded from 
http://www.ooomacros.org/user.php, which is linked to 
http://documentation.openoffice.org/thirdparty.html.  

On the webpage for ooomacros, scroll down the list of macros to 
OOoStatistics and click on <Download>.   

As you know, a frequency distribution may be presented graphically as a 
histogram, a frequency polygon or an ogive. You can use the Chart 
Wizard or the Data Analysis Tool: 

 Click <Tools>, <Data Analysis>, <Histogram> and <OK>. 
 Then enter the input range, bin range and output range as before. 

A B C D
26
27 Bin Frequency
28 120 1
29 160 11
30 200 33
31 240 12
32 280 3
33 More 0
34
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 Click <Chart Output> and then <OK>. 
 When the warning that the output range will overwrite existing 

data is displayed, click <OK>. 

The same frequency distribution as before is displayed, with a histogram 
to the right of it. 

 
Figure 17 

Descriptive statistics analysis 
Excel has an option in its Data Analysis Tools to generate a set of 
descriptive statistics. This requires the data to be in a single column. To 
apply the Descriptive Statistics Tool to the data in column F for year 
2000: 

 Click <Tools>, <Data Analysis>, <Descriptive Statistics> and 
<OK>. 

 Enter in the Input Range box: F3:F15. 
 In the Grouped by options list, select Columns. 
 Click <Labels in First Row> so that a tick mark appears next to 

it. 
 Enter in the Output Range box: A30. 
 Click <Summary Statistics> and <OK>. 



  
 C7: Quantitative Techniques 

 

 

 
33  

This table should appear: 

2000 
  
Mean 184.6667 
Standard Error 5.986517 
Median 184 
Mode #N/A 
Standard Deviation 20.7379 
Sample Variance 430.0606 
Kurtosis -0.96465 
Skewness 0.169377 
Range 66 
Minimum 154 
Maximum 220 
Sum 2216 
Count 12 

Figure 18 

The positive skewness means that more than half the values lie to the left 
of the mean. The negative kurtosis means that tails of the distribution are 
thinner than for a normal distribution. Therefore the probability of 
extreme values is smaller than for the normal distribution. 

The other values are self-explanatory, but you should take some time to 
analyse and interpret them. 

Activity 3.11 

 

Activity 

Analyse data 

What will you do? 

1. Do a Descriptive Statistics data analysis for revenue for the year 1996 
in the data for Figure 15. 

2. Interpret and discuss each of the values in the Descriptive Statistics 
box. 
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Activity 3.12 

 

Activity 

Understand the 
terminology 

What will you do? 

Use this terminology table to record any terms or words you’re uncertain 
about. 

This activity is an opportunity to consolidate your understanding of new 
terminology and concepts you encountered in Unit 10. Fill in the terms 
you have learned and then write your own descriptions of them. 

 

 

Terminology 

Term Description 

 :  

 :  

 :  

 :  

 :  

 :  

 :  

  :  

 :  

 :  

 :  
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Unit summary 
You have successfully completed this unit if you can: 

 

Summary 

 set up tables of data in spread sheets and draw charts and graphs; 

 generate frequency tables and histograms; and 

 analyse data with the Descriptive Statistics analysis tool. 
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Unit 11 

ANOVA and Goal Seek 

Introduction 
Statistical and decision analysis can be complex if done by hand. 
Spreadsheets have tools and functions that make a manager’s work easier. 
Performing analysis of variance (ANOVA) for large data sets becomes 
very simple and Excel’s Goal Seek feature can be used to find unknown 
quantities from complicated equations (such as internal rates of return or 
IRR). 

Upon completion of this unit you will be able to: 

 

Outcomes 

 interpret ANOVA statistics; and 

 find implicit solutions of equations using Goal Seek. 

 

 

Tip 

Remember: In OpenOffice you have to download macros to perform 
statistical analysis. These macros can be downloaded from 
http://www.ooomacros.org/user.php, which is linked to 
http://documentation.openoffice.org/thirdparty.html.  

On the webpage for ooomacros, scroll down the list of macros to 
OOoStatistics and click on <Download>.  

Comparing data sets with ANOVA 
ANOVA stands for Analysis Of Variance. It was invented by Sir Ronald 
Aylmer Fisher in 1920 as a way of determining whether an event was 
most likely due to chance (natural variation). Conversely, it allows one to 
say with 95 per cent confidence whether the event was actually caused by 
some factor. The statistics you consult to make a decision are the F ratio 
and F critical value, named for Sir Fisher, which determine whether a 
result is statistically significant. 

ANOVA is actually a method of comparing data sets. When you compare 
data sets with respect to a certain property, ANOVA looks at the variance 
within a data set and also the variance between sets. It allows us to decide 
whether the difference between data sets is statistically significant, or 
whether the differences are as large within the sets themselves. In the 
latter case, the difference is due to natural variation and not statistically 
significant. 

Let us assume you have entered two or more sets of data in columns in a 
worksheet. Each data set is labelled by its name at the top of the column. 
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The cells containing the labels and data form a block called the Input 
Range. This is how the ANOVA method is then applied: 

 Click <Tools> and <Data Analysis>. 
 Click <Anova:Single Factor> and <OK>. 
 Fill in the Input Range of the data, tick the box “Labels in First 

Row”, then click <Output Range>. 
 Enter any empty cell as output range and click <OK> to get the 

statistics. 

Activity 3.13 

 

Activity 

Do an ANOVA analysis 

What will you do? 

This table gives the rating scores for the performance of three employees 
over five months. You have to determine whether there is a best 
employee and whether the difference between the employees’ 
performance is statistically significant. 

Owami Chris Aasia 

140 138 155 

160 148 162 

158 158 148 

145 165 160 

150 160 158 

1. Do an ANOVA analysis to find the employee with the highest 
average score. 

2. Interpret the output. 

 

Here’s our feedback 
1. Enter the table into cells A1:C6. This is the input range. The names 

Owami, Chris, Aasia appear as the first row. Follow the steps given 
above for comparing data sets with ANOVA. Choose A8 as the 
output range, for example, and click <OK>. The output is shown in 
Figure 19. 

It clearly appears that Aasia has performed best, with the largest total 
score and average, and the smallest variance in scores.   
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ANOVA: Single Factor      
       
SUMMARY       
Groups Count Sum Average Variance   
Owami 5 753 150.6 71.8   
Chris 5 769 153.8 116.2   
Aasia 5 783 156.6 29.8   
       
       
ANOVA       
Source of 
Variation SS df MS F P-value F crit
Between Groups 90.13333 2 45.06667 0.620753 0.553941 3.885294
Within Groups 871.2 12 72.6  
  
Total 961.3333 14         

Figure 19 

2. The question is whether the results are statistically significant. Can 
you say with 95 per cent certainty that the differences in the three 
employees’ scores are significant? Do the scores really signify that 
“Aasia is best”?  

Consult the F ratio (F) and F critical value F crit. 

If F > F crit, then there is a statistically significant difference.  

If F < F crit, then the score differences are best seen as chance 
differences or due to natural variation. 

In this case, F = 0.620753 and F crit = 3.885294. Clearly  
F < F crit and therefore the differences in scores are not statistically 
significant. We cannot say with certainty (95 per cent) that the scores 
of these performances show Aasia to be the best employee. 
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Discussion 

Statistical significance versus natural variation 

In Question 2 of Activity 3.13, we concluded that the differences in 
scores for Owami, Chris and Aasia are not statistically significant. We 
can see this from the variation in scores between employees (measured as 
90.13) being much smaller than the variation within scores of a single 
employee (871.2). Each employee’s own performance varied more within 
the five months than the other employees’ performances varied in 
comparison. So although Aasia’s average score was the best, it is too 
simplistic to say that her performance over five months was the best. 

The mean square or MS value between the employees’ scores is 45.0667, 
and the MS value within an employee’s score is 72.6. The F ratio is 

calculated as F = 
6.72

0667.45
= 0.62075. 

F crit gives the 95 per cent significant F value calculated from the data. 

This is another example where it is unwise to make decisions based on 
simple calculations of averages or sums. When choosing between groups 
of people by comparing averages of characteristics, you should make sure 
that natural variation within any single group is not bigger than the 
significant variation between the groups. 

Discuss some instances where conclusions about the superiority of one 
group over another, based on averages alone, could lead to negative 
consequences. 

Activity 3.14 

 

Activity 

Analyse and interpret 

What will you do? 

The body mass of groups of people from four different countries is 
measured in kilograms. 

Which group has the largest average mass? Can you make a statistically 
significant judgement? 

Use ANOVA analysis and interpret the output. 

Group A Group B Group C Group D 

67 62 72 58 

72 94 65 62 

55 110 96 53 

58 81 98 57 

71 90 118 66 
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Goal Seek 
Consider this situation:  

You want to find the interest rate if the present value PV of two cash 
inflows C1 and C2 at the end of years 1 and 2 is known. 

Let PV = 3,000, C1  = 1,500 and C2 = 2,000. 
The unknown interest rate is R. You must find R from the equation:   

3,000 = 
2)1(

000,2

)1(

500,1

RR 



 

Instead of trying to solve the problem algebraically (try it!), you open a 
spreadsheet. 

 Write the names PV, C1 and C2 and R in column A, cells A1–A4. 
 Enter the formula for PV in B1: =(B2/(1+B4)+B3/(1+B4)^2) and 

the values for C1 and C2 in cells B2 and B3. (Discard the comma 
when you enter values into the spreadsheet.) 

 Enter a “seed” value for R in B4 (say, R = 0).  A “seed value” 
means “starter value”, i.e., a value that sets the process going. 

With this R (=0), the value 3500 will appear for PV in the cell B1. 

But you seek R so as to reach goal PV = 3,000. 

 Click on B1. 
 Click <Tools> and then on <Goal Seek> from the drop-down 

menu. 

This Goal Seek box appears: 

 
Figure 20 

The box for “Set cell:” should read B1. 

In the box for “To value:” enter 3000, and in the box “By changing cell:” 
enter B4. Click <OK>. 

The value for R in B4 should change from 0 to 0.10391. 
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Therefore the interest rate R was about 10.39 per cent for the given cash 
inflows C1  = 1,500 and C2 = 2,000, and with PV = 3,000. 

Activity 3.15 

 

Activity 

Use Goal Seek 

 

What will you do? 

1. The relation between quantities P and Q is given by: 
P2 = 2Q3 + Q2 − 15.46  
Use Goal Seek to determine the value of Q when P = 13.5. 

2. The future value of an ordinary annuity is 24,000 kina.  
There are annual payments of 1,500 kina every year for 10 years. 
What was the annual rate of return over the period?  
(See Module 1, Unit 1, “Annuities” and use Goal Seek.) 

3. Find the monthly interest rate R if the PV of four cash inflows  
C1, C2 , C3 and C4 at the end of each of 4 months is given as:   
PV = 600, C1  = 150, C2 = 200, C3 = 250, C4 = 280 

Activity 3.16 

 

Activity 

Understand the 
terminology 

What will you do? 

Use this terminology table to record any terms or words you’re uncertain 
about. 

This activity is an opportunity to consolidate your understanding of new 
terminology and concepts you encountered in Unit 11. Fill in the terms 
you have learned and then write your own descriptions of them. 

 

 

Terminology 

Term Description 

 :  

 :  

 :  

 :  

 :  

 :  

 :  
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Remember these key points 
Spreadsheets contain powerful tools for analysing data and making 
decisions based on the statistics generated by the software. Once again, 
we emphasise that the interpretation of statistics is a process that demands 
responsibility and sensitivity. In turn, these depend on knowing the 
models and their limits. One example is the question of the statistical 
significance of differences between groups, as opposed to the natural or 
chance variation within groups of data. 

  



Unit 11 ANOVA and Goal Seek 
  

 

 
44 

 

 
 

Unit summary 
You have successfully completed this unit if you can: 

 

Summary 

 implement different data analysis and statistics analysis tools in 
a spread sheet; 

 generate and interpret ANOVA statistics; and 

 find implicit solutions of equations using Goal Seek. 
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Unit 12 

Other spreadsheet facilities for 
model building 

Introduction 
As you progress in building spread sheet models, you will need to use 
more of the functions and objects available in Excel or OpenOffice. 
Building simulation models, for example, requires you to generate 
random numbers. But consulting tables of values to compute probabilities 
for random variables can be cumbersome unless you are using Excel.  

You may also find it useful to record or write your own macros. A macro 
is a set of instructions to perform a sequence of operations, which 
automates the process. Therefore, macros are small programs written, in 
this case, in the Visual Basic (VB) programming language. (Visual Basic 
for Applications (VBA) is the language that manipulates the objects in 
Excel, and VB is the computer language that forms the backbone of 
VBA).  

Upon completion of this unit you will be able to: 

 

Outcomes 

 apply a range of Excel functions in building management and 
business models; 

 implement simple VBA; and 

 understand the use of macros. 

More Excel functions 
Six additional functions that can be used in model building are discussed 
below. Some of these will be applied in the next modules. 

BINOMDIST 
This calculates the probabilities for outcomes or events of binomially 
distributed random variables. The binomial random variable counts the 
number of successes a in a fixed number N of independent runs of the 
experiment. The formula in Module 2, Unit 8 (“Discrete random 
variables”) is not always easy to apply. 

In Excel we use: =BINOMDIST (number, trials, probability, cumulative) 
where number = a, trials = N, probability = p, and cumulative is set to 
TRUE if cumulative probabilities are desired and to FALSE if individual 
probabilities are desired. 
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Here’s an example:  

Look at Activity 2.12, Question 2 again: Laptop components are packed 
into boxes at a factory. Each box contains 25 items. It is said that 15 per 
cent of all items produced are defective. What is the probability of there 
being no defective items in each box? 

In the appropriate cell in an Excel workbook, click <Insert>, <Function > 
and then choose BINOMDIST.  
In the fx line you will see: =BINOMDIST().  
Fill in the values of arguments in the pop-up box: 
 (0, 25, 0.15, FALSE).  
Click <OK>.  
The answer 0.017198 appears. 

NORMDIST 
This calculates the probabilities for outcomes or events of normally 
distributed random variables. You need the mean and standard deviation 
of the random variable as inputs. Only cumulative values are given 
(because these are continuous random variables). 

Here’s an example:  

Look at Question 2 in Activity 2.13 of Module 2:  
If random variable X has the normal distribution with μ = 10 and σ = 5, 
determine the probability P(X > 18).  

In terms of the cumulative probability distribution, you have to find  
1 − P(X ≤ 18). Using Excel, you don’t have to construct the standardised 
normal variable Z. 

In a cell in an Excel workbook, click <Insert>, <Function> and then 
choose NORMDIST.  
In the fx line, you will see: =NORMDIST().  
Fill in the values of arguments in the pop-up box, so that the fx line reads: 
=1−NORMDIST(18,10,5,TRUE). Click <OK>.  
The answer 0.054799 appears. 

IF 
The “IF” function is a logical function that gives an output value 
corresponding to true or false, depending on whether the logical test 
(condition) is satisfied or not. This function is useful in decision-making 
and categorising. 

It has the form: =IF(Logical test, Value if true, Value if false). 

Here’s an example:  

You have the daily closing price for Share A in cell B1 and want to know 
when the share price drops below the critical value of 10. In that case, 
you want “SELL” to appear in cell B3; otherwise you want “KEEP” to 
appear.  

Enter any value for the share price in B1. Click on B3.  
Insert the IF function. Enter the arguments in the pop-up box so that the 
fx line reads: =IF(B1<10,"SELL","KEEP").  
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Press<Enter>. Either SELL or KEEP will appear in B3.  
In Figure 21, B1=9.9 and so B3 =SELL.  
Change the value in B1 to 12.56 and press <Enter>. B3 should read 
KEEP. 

 
Figure 21 

RAND 
This generates random numbers from the uniform distribution. These 
numbers will lie in the interval [0, 1]. The function has the form 
=RAND() and no arguments are entered. To generate numbers between 0 
and 20, enter =RAND()*20. 

Here’s an example:  

You want to generate 10 random numbers (uniformly distributed) 
between 0 and 50 in the cell range A1:A10 to simulate 10 values of a 
certain quantity.  

Click in cell A1, enter =RAND()*50 in the fx line and click <Enter>.  
A number will appear in A1.  
Click A1, click Copy, then highlight A2 to A10 and Paste.  
You will have a column of 10 random numbers. 

RNG (random number generator) 
This generates random numbers from a selection of different 
distributions, including the normal distribution.  

Go to <Tools>, Data Analysis, Random Number Generation and click 
<OK>. Choose the distribution you want, fill in the pop-up box and click 
<OK>. 

VLOOKUP 
This function searches the left-most column in a table for a table value 
that you have specified. It then finds the value corresponding to that in 
another column specified by you as Column no (column number). 

The form is:  
=VLOOKUP(Table value, Lookup table, Column no, Nearest). 
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This function is very useful when searching through large tables of data. 
If you want the nearest (approximate) match, enter TRUE for Nearest. If 
you want an exact match, enter FALSE. 

Here’s an example:  

You employ 1,999 people. Each has a staff number. There is a big data 
(Lookup) table with range A1:D2000 showing job level, salary in 
Jamaican dollars and age, entered against each staff member’s number. 
Staff numbers are not in sequence and not consecutive. You want to find 
the salary (in column 3) of staff member number 17634. A small section 
of the table in columns A to D looks like this: 

Staff number Job level Salary (JMD) Age 

16437 2 92,000 58 

32772 1 165,000 62 

17634 10 16,000 23 

5258 4 58,000 37 

65471 3 68,000 46 

Figure 22 

Click on a chosen output cell (say, E2), then <Insert>, Function, 
VLOOKUP.  
Enter arguments to read: =VLOOKUP(17634,A1:D2000,3,FALSE).  
Enter FALSE because you want the staff number to be an exact match. 
The output is then: 16000. 

 

Figure 23 
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Activity 3.17 

 

Activity 

Practice these functions 

What will you do? 

Figure 24 shows an extract from a data set of daily share price returns (%) 
for five shares over the first 132 trading days in 2008. The total data set is 
in a spreadsheet. The extract shows days 123–127. 

                                             Daily return (%) 

Trading 
day no. 

Share A Share B Share C Share D Share E 

123 2.0 3.55 −4.5 3.4 1.48

124 −1.2 2.1 0.0 1.2 0.0

125 0.0 −2.4 −0.8 1.05 0.0

126 1.4 −3.0 0.6 0.0 −2.8

127 3.6 1.0 1.0 1.18 −1.73

Figure 24 Extract from data set 

All share price returns are normally distributed. 

Copy the extract into a spread sheet in the range A1:F6. 

1. It has been estimated that for 2008 the average daily return for Share 
B is 1.75 per cent and the daily volatility is 2.52 per cent.  

What is the probability that the daily return for Share B will be less 
than −1 per cent? (Use NORMDIST. Also solve this manually using 
the Appendix at the end of Module 2.) 

2. You want to know if the daily return for Share D was higher than 1% 
on day 124. If that was the case, let “GOOD” appear in cell G3; 
otherwise let “BAD” appear. (Use the “IF” function). 

3. Find the return for Share C for day 126 using the VLOOKUP 
function. 

4. Generate random percentage returns for 20 days for Share B. (You 
must use the normal distribution from the RNG function.) 

Visual Basic for Applications (VBA) 
For the purposes of this course, we provide only an introduction to VBA. 
If you have programming experience, you will have few problems in 
implementing it. Practising with VBA in the workplace and in your spare 
time is the only way to really get comfortable with it. Even if you will not 
be using VBA yourself, someone may present you with a VBA model 
and you would at least want to know what it is! 
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Introduction 
VBA in Excel is a tool for expanding the power of spread sheet 
modelling. It is a programming language that you receive with Excel, so 
you don’t need any extra software. OpenOffice does not have this facility, 
although you can download and record some macros.  

VBA enables you to take an Excel spread sheet model and turn it into an 
application that can be used by others who know little about spread sheets 
or programming. Such users will be presented with an easy-to-use “input 
side” where they enter data, and an “output side” where they receive a 
report or answer. 

For example, the end-users want to enter an interest rate and receive a 
report on the value of the NPV and PI and the suitability of the financial 
investment. The users do not have to understand how you modelled the 
problem; they merely want to see the answers and use the answers to help 
them make decisions. VBA does exactly that. 

The Visual Basic Editor (VBE) 
Make sure you have VBA installed. 

Note: In Excel 2003, click on <Tools>, <Add-Ins>, and then check that 
Analysis Toolpak-VBA has been ticked. 

In Excel 2007, you should see these tabs at the top: 
Home, Insert, Page Layout, Formulas, Data, Review, View, Developer. 
The Insert tab contains charts; the Data tab contains Data Analysis and 
Solver; and the Developer tab contains Visual Basic. 

If you cannot see the Developer tab, click again on the Microsoft button 
at top left. Click <Excel Options> at the bottom, then click <Popular> 
and select Show Developer Tab in the Ribbon. The Developer Tab 
should now show at the top in the list of tabs 

You find the VBA Editor by opening Excel. You should have spread 
sheet Book 1 open. 

Click on <Tools>→ Macro →Visual Basic Editor. Or just press Alt-F11. 

Now you will see a large grey code window on the right. 

There may be a Project Explorer window and a Properties window on the 
left. If they are not there, click on <View> in the VBA toolbar and then 
on <Project Explorer> and <Properties Window> to open these windows. 

You can open and close these windows. (Click on <X> to close a 
window.) Keep the Project window open. 

This is what the screen looks like: 
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Figure 25 

Note: There are two other useful windows: Immediate and Watch.  

Immediate can be used for one-line VBA commands that you want to 
execute immediately.  

The Watch window is for debugging (getting rid of programming errors). 
We will not use them now, but they can be found under the View option 
on the VBA menu bar.   

Next, you will have to open a project and a module to work on. To insert 
a module, click on <Insert>→Module on the menu bar. You will see 
Module 1, Book 1. The white space is the window where you will type 
your VBA code (see Figure 27). You can enlarge the code window by 
clicking on the icon  , next to the box with  in it, on the right of 
Module 1 (Code). 

Click on <View>→Toolbars to make sure you have the Standard, Edit 
and Debug toolbars open. (You open and close toolbars by clicking to the 
left of whichever toolbar you want to open or close.) Click on the icons to 
see what features are available. The Object Browser on the standard 
toolbar is a good help tool. 

Click on <Tools>→Options. Check  the Require Variable Declarations 
box and uncheck the Auto Syntax Check box. 

You may also have to set your security in Excel to Medium instead of 
High. Microsoft sets security on High by default, but this can mean your 
VBA code will not run. You reset the security by going back into Excel. 
To get back to Excel, click on the Microsoft Excel tab at the bottom of 
your screen. In Excel, go to <Tools>→Macro→Security, as shown in 
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Figure 26. Click on <Security> and select Medium. This is very 
important! 

 
Figure 26 

To go back to VBA, just click on <Microsoft Visual Basic> at the bottom 
of the screen. 

Don’t feel overwhelmed by all the unfamiliar words, toolbars and 
windows. It takes practise to get used to everything. 

Now close the VBA Book 1 from the File menu on the toolbar. Close 
Excel. Start all over again by opening Excel, going to VBA Editor and 
opening a module. 

The line Option Explicit will appear in the code window (Figure 27). This 
is to remind you that you had previously chosen  Require Variable 
Declarations from Tools→Options. 

 
Figure 27 
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Why did we choose Require Variable Declarations? Because VBA will 
then remind you that you have to declare the variables in a program. In 
Example 2 from Sample VBA Programs (coming next), you will see how 
variables are declared. 

Variables such as i, j, numberHigh, totalCost, or whatever names you 
choose in a program, take on numerical values during the execution of the 
VBA program. Variables i and j will typically take on values 1, 2, 3, and 
so on; variable total Cost will typically be a monetary value. 

Variables i and j have to be declared as integers so that VBA knows how 
to handle them and the computer knows how to store the values in its 
memory. This is done with the statement: 
Dim i As Integer, j As Integer 

Variable totalCost will be declared as Currency with the statement: 
Dim total Cost As Currency 

Integer values must lie between −32768 and 32767. Integers outside this 
range must be declared as Long. Decimals are declared as Single or 
Double. 

Variables can also take on non-numerical values such as names, or True 
or False. If variable first Name can take on values such as John, Mary, 
and so on, it is declared as: 
Dim first Name As String 

If variable isThere can take on the values True or False, it is declared as: 
Dim isThere As Boolean 

Each type of variable requires a certain amount of memory and VBA 
handles it in a certain way. Declaring variables helps the program to run 
smoothly. It is customary to give the Dim statements after the opening 
line of your program. 

Note: In programming languages, there are often statements such as: 
total Cost = total Cost + 100 

This means that whichever value the variable total Cost had in the 
memory, this old value (on the left-hand side of the = sign) will now be 
replaced by a new value, namely the old value + 100, as specified by the 
right-hand side of the = sign.   

Sample VBA programs 
Example 1:  

Follow these steps for a friendly first macro (VBA program). 

1. Open the VBA Editor by pressing Alt-F11 or click on <Tools>→ 
Macro→Visual Basic Editor. 

2. Open a module (<Insert>→Module). This module (named “Module 
1”) will contain the VBA code that you write for the “friendly 
program”. The Code window is the open blank space on the right. 
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3. Start a sub-routine (sub). This is a piece of code that performs a 
specific task. You start a sub by clicking in the Code window and 
typing Sub followed by the name of the sub-routine. In this case, you 
can type: Sub show Message() 

4. Press Enter. You will see End Sub appear in the code window. VBA 
adds it automatically because every sub-routine must end with this 
line. You will also see the name showMessage at top right. 

 
Figure 28 

Save the program by clicking on <File> on the toolbar and then on 
<Save Book1>. Save it in the My Documents folder and give it any 
name (for example, FriendlyVBA.xls) by typing the name in the File 
Name box to replace Book1.xls and clicking on <Save>. 

5. Now press the Tab key – this causes lines of the code to be indented 
so that the code’s structure is clear. Then enter the next line of code, 
exactly as shown, between the Sub and End Sub lines: 
Msg Box “Hello Everybody!” 

6. Place the cursor at the end of End Sub. Run the program by clicking 
on the <Run> button on the top menu and then <Run Sub>. Or just 
press F5. 

7. A message box will pop up in Excel with the message: 
Hello Everybody! 

8. Click on <OK> to return to the VBA program. 

9. Click on <File> in the toolbar and then <Close> and return to 
Microsoft Excel. Or just click on <X> at the top right of the VBA 
program. You have written your first VBA macro. Save and close the 
file Friendly.xls. If Excel warns you that you haven’t saved your 
changes, make sure you save before you close the program. 
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Example 2:  

A company has three branches and monitors sales over 12 months. The 
data is:  

Month Branch 1 Branch 2 Branch 3 

Jan 150000 123500 160000

Feb 110120 98450 154000

March 108050 96300 150674

April 112300 92150 146866

May 111000 98500 145000

June 120500 89600 138800

July 116335 96300 131200

Aug 115700 98521 141750

Sept 129645 116560 145600

Oct 135000 121000 152900

Nov 141890 126000 159500

Dec 155668 132900 172100

Figure 29 

The numbers represent sales figures in dollars. 

You are asked to write a spread sheet application that will show how 
many months of the year the sales in each branch were above a certain 
value. A user of this program does not want to see any programming 
code, but wants to be able to simply type in an amount such as 110000 
and immediately see, for each branch, how many months of the year the 
sales were above USD 110,000. 

1. Open a file in Excel, type in the data and save the data as 
Salesdata.xls. The numbers (amounts) must lie in the range B2:D13. 
Remember to make sure that you have set your security in Excel to 
Medium so that your VBA code will run. 

(Go to <Tools>→Macro→Security and select Medium.) 

2. Activate VBA by pressing Alt-F11. Make sure the Project Explorer 
window is open (<View>→Project Explorer). In the Project Explorer 
window, make sure VBA Project Salesdata.xls is highlighted. (Click 
on it if necessary.) 

3. Open a module (<Insert>→Module). This module (named “Module 
1”) will contain the VBA code that you write for the sales data. The 
Code window is the open blank space under Salesdata.xls - Module 
1(Code). 
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4. Start a sub-routine (sub). This is the piece of code that performs the 
specific task of monitoring sales. You start the sub by clicking in the 
Code window and typing: Sub CountHighSales() 

Press Enter. You will see CountHighSales appear at the top right of 
the window. This is the name of the program you are writing. The 
aim of the program is to count the number of high sales in each 
branch. You will also see End Sub in the window. VBA adds it 
automatically, because every sub-routine must end with this line. 

5. Type the code between Sub CountHighSales() and End Sub: 

First, press the Tab key – this causes lines of the code to be indented 
so the code’s structure of the code is clear. Then enter the lines 
exactly as shown and press Enter after each line. Press Tab for every 
indent that you want to make. Press Backspace to remove an indent. 
Other words and comments will appear as you type, but don’t worry 
about them now. Be very careful to type exactly as shown: the syntax 
of computer code must be perfect!  

There is a space before the underscores _. The underscore is used 
when a line of code runs over to the next line. Otherwise you must fit 
in each line of code on a line. The character “&” must also have a 
space before and after it. Afterwards, save the code. 
 
Sub CountHighSales() 

Dim i As Integer 

Dim j As Integer 

Dim numberHigh As Integer 

Dim salesCutoff As Currency 

  

salesCutoff = InputBox("What sales value do you want to check 
for?") 

For j = 1 To 3 

numberHigh = 0 

For i = 1 To 12 

If Range("B2:D13").Cells(i, j) >= salesCutoff 
Then _ numberHigh = numberHigh + 1 

Next i 

MsgBox "For Branch " & j & ", sales were above " & _ 

Format(salesCutoff, "0 000") _ 

& " on " & numberHigh & " of the 12 months." 

Next j 

End Sub 
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Remember: The underscore _ is used when a line of code runs over to 
the next line because you cannot fit it in one line. You may use this 
wherever you need to. You should now see the same as shown in Figure  
30. 

 
Figure 30 

6. Now run the program. Place the cursor anywhere in the sub-routine 
and click: <Run> → Run Sub/User Form, or press F5. You should 
see a box like Figure 31 pop up in the workbook: 

 
Figure 31 
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Enter any value (for example, 110000). Click on <OK>. A box will 
pop up with the answer: 
For Branch 1, sales were above 110000 on 11 of the 12 months. 

Click <OK> again, and another box will pop up with the answer: 
For Branch 2, sales were above 110000 on five of the 12 months. 

Click <OK> again, and another box will pop up with the answer: 
For Branch 3, sales were above 110000 on 12 of the 12 months. 

Click <OK> again, and you can enter fresh values (for example, 
120000). 

7. Study the code to see if you can follow the logic and get a feel for 
VBA. 

8. Save and close all files. To open the workbook again, open Excel, 
open Salesdata.xls, press Alt-F11 and your code will appear as 
“Module 1”. (You will have to click on <Enable Macros> first.) If 
there are any problems, make sure you have set your security in 
Excel to Medium instead of High. 

9. Optional exercise: To make the macro more user-friendly, go to 
Excel and into the file Salesdata.xls. 
Right-click on the top toolbar to see a list of toolbars. 
Click on <Forms>. A little toolbar will appear, which you can move 
to where you want it. 
Click on the icon (at right, second from top in the small Forms (Fo) 
toolbar) that reads “Button” when you hold your cursor over it. Then 
click on a spot next to the sales data. 
A box with names will appear. 
Click on <CountHighSales> to make sure you go to the right VBA 
file (in case you have saved other VBA files). 

10. Click on <OK>. A box labelled “Button 1” will appear. Enlarge this 
box by holding the cursor over the right-hand side so that ↔ appears. 
Left-click on the mouse, hold down and drag the mouse to the right. 
You will see how the box enlarges. 

11. You can remove the Forms toolbar by clicking on <X> at the top 
right of the Fo toolbar. 

12. Place the cursor inside the button box in front of the letter B, delete 
the words “Button 1” and type in your own name for the button, such 
as: “Months with high sales”. 

13. Click outside the button box. There will now be a grey button 
labelled “Months with high sales”. When you place the cursor over 
the grey button, a hand symbol will appear. Click it and the question 
“What sales value do you want to check for?” will appear.  

Values can now be filled in, as before. With each click on <OK>, the 
answers will appear. 

14. Users now only have to open the Excel file called Salesdata.xls, click 
on <Enable Macros>, click on the “Months with high sales” button 
and proceed. They will not see the actual VBA macro. 
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Error messages  

You may get an error message when you try to run a program. If a line is 
coloured red, you have typed it incorrectly. If you get a run-time error, 
click on <End> and try to find and fix errors. If you click on <Debug>, a 
line will be indicated in yellow. This means the error is in, or close to, 
that line. 

Intellisense 

This is a feature of the VBA Editor. You will notice that when you type 
in code, comments will appear or words will be completed for you. This 
is to help you make fewer mistakes. 

There is not time for a more detailed analysis, but you should now at least 
have an idea of how VBA macros are structured. 

Recording macros 
The operations and commands that you use in Excel files to build 
spreadsheet models can automatically be changed into VBA code, stored 
and applied to other data. The recorded program is called a macro. Using 
macros makes you a sophisticated user of Excel. 

Recording macros is also another means of learning about programming 
in VBA. The recorded program is usually not very elegant, but it provides 
a way for you to see how to create VBA code. 

To record actions in Excel, open a new file in Excel and click: 
<Tools>→Macro→Record New Macro. 

Give the macro a name and store it, preferably in Personal Macro 
Workbook. If you store it in This Workbook, you can only use it in that 
particular workbook. 

After you have clicked <OK> on the Record Macro box, a Stop 
Recording box will pop up. This allows you to click to stop recording. If 
the Stop box does not appear, right-click on a toolbar and then click on 
the Stop Recording item. 

Here’s an example:  

We enter a set of data, name the range of values, and sum the values in 
Excel. This process is recorded. 

1. Open a new Excel file and name it SumCosts. 

2. Enter this table in cells A1:B13. 
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Month Cost 

Jan 5000

Feb 1120

March 8050

April 2300

May 1000

June 500

July 6335

Aug 5700

Sept 9645

Oct 5000

Nov 1890

Dec 3668

Figure 32 

3. In cell A14, type “Total cost”. 

4. Turn the recorder on with <Tools>→Macro→Record New Macro, 
and name it “SumFormula”. Store it in the Personal Macro 
Workbook. Click <OK>. 

5. In cell B14, enter = SUM(B2:B13). This will be recorded. 

6. Click the Stop recording button on the Stop box. The process of 
finding the sum of numbers in a column has been recorded. 

7. To see what the code looks like, press Alt-F11. Click on the + next to 
VBAProject (Personal.xls) in the VBA Project Explorer. Click on the 
+ of the Modules. 

8. Double-click on the “Module 2” folder (or whichever module 
contains the macro) to see the recorded macro, as shown in Figure 33.  
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Figure 33 

9. You can now create a new Excel file and enter new data for 12 
months in cells B2:B13. Click on <Tools>→Macro→Macros. The 
name of all your macros, including the recorded macro SumFormula, 
will appear. Choose SumFormula. 

10. Click on <Run>, and the values in the range of cells will be added, 
with the sum appearing in cell B14. 

 

 

Case study: 
Group research project 

This case study involves accountability ratings for companies. 
Accountability is defined as “a company’s ability to explain and justify 
its actions, and to take responsibility for the consequences of those 
actions” (Accountability Rating™). 

Accountability Rating™ evaluates companies in four key areas (see 
www.accountabilityrating.com):  

1. Strategic intent: Does the company seek to address important social, 
environmental and broader economic issues in its core business 
strategy? 

2. Governance and management: Are senior executives and the board 
accountable to stakeholders when setting strategy and formulating 
policy on extra-financial issues? 

3. Engagement: Does the company engage in dialogue with the people 
and groups who have an interest in its business, may be affected by it 
or have an effect on it? Does the company publicly report its social 
and environmental performance? 

4. Operational performance: How effective has the company been in 
implementing its management systems and engagement mechanisms? 
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 The four areas are equally weighted and companies are scored. 
Accountability Rating™ publishes the scores for the world’s largest 100 
companies in Fortune magazine every year. It also ranks countries and 
regions. 

A study was done in South Africa using Accountability Rating™ 
measures (“Correlates of corporate accountability among South Africa’s 
largest listed companies by Eccles, Pillay & de Jongh, Southern African 
Business Review, 2009). The authors reported statistically significant 
relationships between accountability and company size and industry 
sector. On this basis, they suggest that a company’s size and its industry 
sector motivate socially responsible corporate behaviour. 

Group assignment: Your group should do at least one of these: 

1. Register on www.accountabilityrating.com and study the 
methodology of the rating model.  

Study the findings. Write a paper discussing and/or critiquing the 
methodology and findings. 

2. Read the paper “Correlates of corporate accountability among South 
Africa’s largest listed companies”. You can access the paper from the 
journal’s website: http://www.unisa.ac.za/sabusinessreview. 

Do a data analysis on the authors’ data to see whether you agree with 
their findings. Write a report. 

This is a more challenging and long-term project and can be tackled at the 
end of Module 5: set up a questionnaire along the lines of Accountability 
Rating™ and send it to companies in your own country. Collect and 
organise the data and perform a data analysis like the one undertaken by 
the Southern African Business Review. Write a short paper discussing 
your results and see whether you can have it published in a local journal 
or magazine. 
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Activity 3.18 

 

Activity 

Understand the 
terminology 

What will you do? 

Use this terminology table to record any terms or words you’re uncertain 
about. 

This activity is an opportunity to consolidate your understanding of new 
terminology and concepts you encountered in Unit 12. Fill in the terms 
you have learned and then write your own descriptions of them. 

 

 

Terminology 

Term Description 

 :  

 :  

 :  

 :  

 :  

 :  

 :  

  :  

 :  

 :  

 :  

 

Remember these key points 
This unit introduced additional Excel functions. It also showed you the 
basic ideas behind VBA and how you can use it to enhance the modelling 
of management processes and the presentation of your final model. 
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Unit summary 
You have successfully completed this unit if you can: 

 

Summary 

 implement some additional functions in spreadsheet modelling; 

 generate random numbers; 

 write simple programs using VBA; and 

 record macros. 
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Assessment 

 

Assessment — Module 3 

 

1.  

a) Do a Descriptive Statistics Analysis for the data in Figure 34.  
Discuss all results. 

Year Pension fund return % 

2000 10.00 

2001 11.50 

2002 13.80 

2003 14.43 

2004 10.50 

2005 15.00 

2006 12.28 

2007 17.45 

2008 −1.06 

2009 −2.00 

  Figure 34 

b) Present the data in a column chart and record a macro in VBA as 
you draw the chart. 

2. You need a frequency distribution for the table of data. It describes 
the consumption of electricity (in kilowatt hours) of 40 households 
over the period of a month. Present the outcome as a histogram. 

 

122 88 145 150 79 

143 145 134 157 145 

210 163 234 85 156 

88 110 162 99 154 

122 156 210 245 160 

145 184 215 141 183 

163 215 163 107 145 

143 163 145 200 156 

  Figure 35 
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3.  

a) Find the value of the internal rate of return IRR from the relation: 

 
)1(

1

IRR

C


 + 

2
2

)1( IRR

C


 + 

3
3

)1( IRR

C


 +…+ 

n
n

IRR

C

)1( 
 = C0

  

The annual cash flows are: 

C0 = 12,000, C1 = 5,000, C2 = 6,000, C3 = 6,500, C4 = 5,000, C5 = 6,000 

b) Use both Goal Seek and the IRR function to find and compare 
answers. 

c) Investigate the changes in IRR as you vary the initial investment 
C0. 

4. The “intelligence quotients” (IQ) of three groups of students are 
tested. Groups A, B and C correspond to highest-income families to 
lowest-income families. The researchers claim that students in Group 
A are the most intelligent because their average IQ is above 120 
(namely 123.75). They also claim the students in Group C will not 
finish college because their average IQ is below 120, and the lowest 
at 117.88. 

a) On a purely statistical basis, analyse the results (using ANOVA) 
and report your findings. 

b) Critique the study on grounds such as sample size, ethics and the 
validity of using a measure such as IQ. 

The data collected by the researchers is displayed in Figure 36: 

Group A Group B Group C 

135 120 120

130 125 118

100 110 125

140 130 128

100 90 125

95 140 120

145 100 130

105 118 120

Figure 36 

5. Write a VBA program for the data in Question 4 that enables a user 
to find out how many students had IQ scores above a certain value in 
each group. 

6. Figure 37 gives an extract from a data set of daily share price returns 
(%) for four shares during 2007. 
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   Daily return (%) 

Trading 
day no. 

Share 1 Share 2 Share 3 Share 4 

101 1.0 1.5 −4.5 2.4 

102 −1.2 2.1 0.1 −1.2 

103 0.5 −1.4 1.8 1.05 

104 2.4 −0.4 0.6 0.0 

105 1.6 −1.0 1.2 −1.18 

106 0.4 0.2 1.0 −2.2 

 Figure 37 

All share price returns are normally distributed. 

Copy the extract into a spread sheet in the range A1:E7. 

a) It has been estimated that, for 2007, the average daily return for 
Share 1 is 2.1 per cent and the daily volatility is 3.52 per cent. 
What is the probability that the daily return for Share 1 will be 
more than 2.5 per cent? (Use NORMDIST. Also solve this by 
hand, using the table at the end of Module 2). 

b) You want to know if the daily return for Share 2 was higher than 
2 per cent on day 102. If that was the case, let “HIGH” appear in 
cell F3; otherwise let “LOW” appear. 

c) Find the return for Share 3 for day 105 using the VLOOKUP 
function. 

d) Generate random percentage returns for 20 days for Share 4. (Use 
the normal distribution from RNG as random number generator.) 
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Reading 
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